Back to the Big Challenge

BACK TO THE BIG CHALLENGE INTRODUCTION

Learning Set 2
Back to the Big Challenge

Which regions of a newly discovered planet
have appropiate surface temperatures for a
human colony?

1 .
t 1 > class periods*

Overview

Students have now have the information they need to answer the question of

this Learning Set: How does a planet’s shape affect surface temperatures?
They will now complete prediction maps of sutface temperatures on Planet

X, using the data that they’ve already collected. They will then use Solution
Briefings to communicate their solutions to the rest of the class.

Targeted Concepts, Skills, Performance Expectations

and Nature of Science

The shape of a planet directly affects its surface Students should be able to have completed

temperatures. a prediction map for Planet X. They should
also determine which regions of Planet X
are habitable.

Materials
1 per student computer with My World software

@ @ L . B
Activity Setup and Preparation A class period i
considered to be one
Before students enter the classroom, you may want to start up their 40 to 50 minute class.

computers and have the blank map of Planet X ready for them.
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Homework Options

If you do not have time to do the Solution Briefing in class, you may
wish to have the students prepare these materials at home and give the
presentations at the next class time.

Reflection

*  Science Content: How has the exercise with Planet X gotten you
closer to meeting the Big Challenge? (Students should refer back to
the bulletin from the CSA where it states that Planet X is very close to
Earth in size.)

Preparation for Learning Set 3
*  Science Process: Now that you know how a planet’s shape can
affect its surface temperatures, predict some ways that a planet’s
tilt could affect its sutface temperatures. (Students’ answers
will vary.)
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BACK TO THE BIG CHALLENGE IMPLEMENTATION

Learning Set 2
Back to the Big Challenge

Which regions of a newly discovered planet have
appropriate surface temperatures for a human colony?

In this Learning Set you were answering the question, How does a planet’s
shape affect surface temperatures? You will now create a map showing
your predictions of the surface temperatures on Planet X. You will use the
data you collected during the investigations you did in this Learning Set.
You will then use your predictions to identify areas that are habitable on
Planet X.

You are going to paint a blank map to show what you predict the average
temperature will be at each latitude on Planet X. You will base your
predictions on the fact that this new planet is shaped just like Earth. Use
what you have learned about shape and solar energy to determine the
surface temperatures of Planet X.

Procedure: Temperature Map for Planet X

1. Open Blank Planet X Map

a) Begin by opening My World. Select “Planetary Forecaster” from
the Data Library drop-down menu.

b) Open the “Planet X.m3vz” project file. You will see a latitude
and longitude grid for Planet X. You do not know much else about
this planet yet.

c) Save your blank Planet X project according to your teacher’s
directions. In the File menu, select “Save Project As.” Add the
names of the people in your group to the file name. For example,
“Planet X Jen Tim.” This will be the project you use throughout
your investigation about Planet X.

2. Paint Temperature Prediction Map for Planet X.

a) Go to the Edit tab. Click the “Zoom to All” tool |:! to view
the full map.

Project-Based Inquiry Science

Guide

Ask a few students to review their findings on the effects of shape on the
surface temperature. They should remind each other that as you travel
farther away from the equator, the incoming solar energy is striking the
sutface at a progressively less direct angle. As the solar energy gets less
direct, it spread out more and heats a larger area, resulting in lower overall
heating and lower temperatures.

Armed with this information, students can now make their first predictions
about how the temperatutes on different parts of Planet X will vary.
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Back to the Big Challenge

1 :
t1 5 class periods*

Learning Set 2

Back to the
Big Challenge

Procedure:
Temperature
Map for
Planet X

20 min.

Students create a
visualization in My
Wortld of their surface
temperature predictions
on Planet X.

*A class period is
considered to be one
40 to 50 minute class.
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O Get Going

Have students get out the answers to the reflection questions from the
previous lesson. Tell students that they will use the results from these
previous investigations to create their predictions. Have students follow the
My World instructions in their student books.

O Get Going

Have students open the project file “Planet X Project.m3vz” and save a copy
of the blank project map using a naming scheme you determine (such as
“|student name] Planet X.m3vz.”). The instructions will direct the students
to save their files in a location you specify. You have a few options for this:
students can save to a portable storage device, to the computet’s Desktop,

to a directory you specify on the hard drive, or to a directory you specify on
a network (if one is available).
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b) Select the “Planet X” layer in the Layer List to open the

L)

painting tools.

Select the paintbrush #

oo ' DEEKEE T

in the toolbar.

d) Notice the Brush Size bar. You can adjust the size of your

paintbrush by clicking on the arrow and dragging it left and right on
the Brush Size bar. The smallest size you can color is one square,
(or cell) on the grid at a time. If you drag the arrow to the far right
side of the Brush Size bar, you can color a large square, ten cells

Back to the Big Challenge

If you do not have
computers available, the
students can complete
this project by coloring
copies of maps. The
maps they create from
this project will be the
base for the rest of the
Big Challenge. They will
continue to progress
through the program by
adding to these maps
of Planet X. Using My
World, the students

will be able to add and

tall and ten cells wide. alter the maps as they

— — go. However, if the
m—— = I — students are coloring
P = e | A paper copies of maps,

=—— they will need to create

- = — | TTTE— new versions at each

point instead. Keep this
e) Select a color from the color bar. This is the bar with the range in mind and be sure to

of colors showing the color key. Position the paintbrush over the have
: . plenty of paper
color you want to select and click. In the box to the right of the copies if you choose

color bar, you can see what value is selected and the temperature it hi o]
represents. this method.

f) Save your Planet X Prediction Map. You will use this map
throughout the rest of the Unit. Since you have already saved

and identified this project file with your group name, simply use °
“Save Project” in the File menu. Procedureo

L3
. Habitable Areas
Procedure: Habitable Areas Map for Planet X
You have created (and saved) your prediction for the new planet based on Map for
shape. You can now identify the habitable areas based on this prediction. Pl t x
CSA has requested that regions with average surface temperatures of 25°F to ane

85°F belocated. Prepare a Habitable Areas Map based on your Temperature- 1 5 .
Prediction Map. min.

1. Open your Planet X project file in My World. Select “Open
Project” in the File drop-down menu. This project file may already Students then use

be open. software functions to
mathematically select
CEEE PLANETARY FORECASTER the areas that meet
habitability criteria.

QO Get Going

After students make their predictions, they are to identify those areas of the
new planet that are habitable (i.e., those areas that ate between 25° F and
85° F based on their predictions so fat). Have students save the selection
showing habitable areas as “Shape Habitability.”

PLANETARY FORECASTER
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. Learning Set 2 * How Does a Planet’s Shape Affect Surface Temperatures?

2. Identify ranges for areas that are habitable.

a) Go to the “Analyze” tab. Go to the “Select” folder and click on
“By Value.”

b) Under the “Select Records From:” drop-down menu, choose
“Planet X.” Under the “Whose:” drop-down menu, choose
“Temperature Prediction.” Check “Less Than” and enter 85. Select
“Greater Than or Equal to” and enter 25.

c) Under “Result Name,” type in the title “Shape Habitability.”
Do not check the box called “Make Selection a New Layer.”

d) After you have filled out the page to select by value,
click “OK.”
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/\ Guide

The process for creating the model for surface temperatures on Planet X is
similar to the exercise students completed in Section 1.1. Help guide them
through this process and encourage them to use the data and material they
have collected from Learning Set 2 to complete the exercise. Once they
have created a temperature map, they will use M) World to show habitable
locations based on the temperature range given by the CSA. You may wish
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to have the students print a copy of their maps when they are done to keep
posted or handy in their science journals as they continue to explore other
factors.

[] Assess

Students should complete the Reflect questions while they can still access
their habitability predictions. If they complete the Reflect questions eatly,
they should complete the What's the Point? reading in their books.

PLANETARY FORECASTER
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Back to the Big Challenge

3. Show Habitable Areas. Go to the P T — e p—————
“Visualize” tab to observe the selection
titled “Shape Habitability.” In this selection,
places where you predicted the temperature
to be too hot (above 85°F) or too cold
(below 25°F) to be habitable have been
hidden. You may have to modify your

T2 Lt & | ongle | sbts (1 %

visualization screen to see your selection. Ui o Lt & Lohglide ..]
a) In the Layer List, select the [ L TR |
“Planet X” layer. In the bottom left ] o ¥ .I'
corner, find the small arrow and make cuee B .
sure this arrow is pointing down. If the
arrow is pointing to the right, click on e e
it to turn it. Under “Highlight Mode,” =
select “Hide Unselected.” I T
b) Select the “Shape Habitability” I j:: ?:::,
o radio button to view only the areas [ErE
Commllnlcate that you have predicted will be (S 00 b
° habitable. I8
Your Solution =
q 4. Save your solution. Select “Save Project” | e
2 0 min. in the file drop-down menu. J"f ::';':_:: -

As you move through the rest of this Unit you

will make adjustments to this map. Here, you predicted what Planet X’s
temperatures are based on shape. You will save this solution and then
make adjustments to it as you learn more about the factors that affect
surface temperature. It is this map that you will edit throughout your
investigations about Planet X.

Communicate Your Solution
Solution Briefing

Remember, a Solution Briefing is a presentation that allows presenters and
audiences to communicate effectively about an idea or solution. The Solution
Briefing provides an opportunity to hear what people have tried and what
they have learned from their attempts at solving the challenge.

PLANETARY FORECASTER

Guide

Remind the students that a Solution Briefing is not about being cotrect.
Rather, it is an opportunity to share thought processes. Encourage the
students to present their Solution Briefings as a personal narrative, including
their thought processes along the way. As students continue sharing, they
should be exposed to different ideas that expand their understanding of the
task.
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Learning Set 2 * How Does a Planet’s Shape Affect Surface Temperatures?

The goal of a Solution Briefing is that everyone should better
understand how a particular person approached the challenge. You
get the opportunity to see a variety of solutions that might work, which
solutions are the most promising, and why. You can also learn what
both successful and unsuccessful solutions show about the way the world
works.Your presentation during this Solution Briefing should focus on
the following points:

® Present the general look of your solution. Explain where you
observe temperature differences on your map.

® Tell others how the data you collected and science content
you learned during this Learning Set support the temperature
predictions you've made for Planet X.

® Discuss how the class explanation of shape supports the solution
you have created so far. If your solution purposely does not match
the class explanation, tell the class why this is so. Provide them
with an explanation that better fits your idea.

As you listen, it will be important to look carefully at the solutions on each
map. You should ask questions about how each map matches the ideas and
knowledge you have learned during this Learning Set. Be prepared to ask
(and answer) questions such as these:

® As the map was being created, what changes did you make that
are not visible in the final map?

How well does the map match up with the class’s explanation of
how shape affects temperature?

® Are there areas that do not seem to match the explanation?

® Which areas seemed difficult to make decisions about?
Which areas were easy to decide?

® Are there any changes this group might want to make on their
map at this time? If so, why?

Be sure to fill out a Solution Briefing Notes page as you listen to
everyone’s presentation.

Project-Based Inquiry Science

/1_43\
PLANETARY FORECASTER



: Learning Set 2
PBIS :

Back to the Big Challenge

Update the Update the Project Board
o
Now that you know more about how shape affects a planet’s surface
Pro]e‘:t Board temperature, your teacher will help your class update the Project Board.
10 min. Describe what you learned from the investigations and the science readings

in this Learning Set. As the class Project Board is updated, make sure you
record the same information on your own Project Board page.

Have students update .
What'’s the Point?

the Project Board

; : You have just used what you have learned about shape to create a predicted
wltb new ideas d?’ld surface temperature map for Planet X. You also determined which regions
queg[ionsl of Planet X might be habitable. This is the start of your proposal to the

Cooperative Space Agency. As you learn about the other factors that
affect surface temperature you will continue to update your habitability
predictions.

You finished studying one
the four major factors that
are responsible for surface
temperature variation on Planet
X. You still need to study tilt,
land and water differences, and
elevation. Your predictions for
the habitable area of Planet
X will probably change as you
investigate these factors in the
next learning sets.

This mountainous area of the
state of Oregon sits at a latitude
of approximately 45°N. Will this

area receive large amounts of direct
incoming solar energy?

@ PLANETARY FORECASTER

Guide

Have students gather after the Solution Briefing and update the Project
Board. The students should be starting to think about the other three factors
presented by the CSA. These factors are:

® Tilt of the planet’s axis
e T.and/water differences

e Surface elevation

144 D
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Assessment Options

Targeted Concepts,

Skills, and Nature How do | know if students got it?
of Science

The shape of a ASK: List some ways of how a planet’s
planet directly shape affects its surface temperatures.
affects its surface

LISTEN: Students’ answers will vary but
they should mention terms such as latitude
and longitude, distance from the Equator,
and direct/indirect light.

temperatures.

Teacher Reflection Questions

* As students complete Learning Set 2, and create the visual in My
World, they still actually know very little about the factors that
create temperatures on Earth (and Planet X). However, they have
completed investigating the first factor. Do now have a good
understanding of how shape contributes?

* As students tie in the concept of latitude, are they able to create a
realistic model of temperatures based on this factor?
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